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1. UVOD 
Cilj ovog završnog rada bila je usporedba topografske karte Svete Nedelje mjerila 

1:25000(TK25) s visina dobivenim iz satelitske misije SRTM. 

Prvo će se dati kratki opis metodologije koja je korištena pri izradi završnog rada. Opisani su 

GIS softveri  s naglaskom na QGIS, podjela podataka u GIS-u, prostorna analiza te interpolacija 

koja je korištena pri izradi završnog rada i na kraju opis SRTM modela. 

Detaljno će se opisati vektorizacija slojnica, TIN interpolacija i usporedba visina. Korišteni 

podatci su karta Svete Nedelje mjerila 1:25000 (TK25) i SRTM model visina dobiven iz 

satelitske misije SRTM. U prvom dijelu opisana je vektorizacija slojnica napravljena pomoću 

QGIS softvera. Opisan je i postupak prostorne interpolacije pomoću metode TIN interpolacije 

te koraci u QGIS-u pomoću kojih je stvorena karta. Posljednji opisani korak je usporedba visina 

pomoću QGIS-a. U rezultatima prikazana je razlika na lokaciji jednog piksela između 

tin_modela_htrs96 koji je digitalni model terena dobiven iz slojnice u HTRS96 koordinatnom 

sustavu i srtm_sveta_nedelja.tif koji je digitalni model terena za to područje dobiven pomoću 

satelitske misije također u HTRS96 koordinatnom sustavu.  

Na kraju će se dati zaključak o metodama i rezultatima pri izradi digitalnog modela terena. 
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2. OPIS METODOLOGIJE 
U ovom poglavlju ukratko će se opisati metodologija korištena pri izradi 3D modela iz 

kartografske podloga . 

2.1 GIS 
Geoinformacijski sustav ili geografski informacijski sustav (GIS) je sustav za upravljanje 

prostornim podacima i osobinama pridruženima njima. 

Geoinformacijski sustavi su računalni sustavi koji se sastoje od prikupljanja, pohrane, 

upravljanja i analize podataka uzimajući u obzir i njihovu prostornu komponentu. Najvažniji 

dio je vizualizacija i prikaz prostorne komponente, te mogućnost izvođenja raznih dinamičkih 

prikaza. 

GIS tehnologija može se koristiti za analizu poslovnih poteza, znanstvena istraživanja, 

upravljanje resursima, upravljanje imovinom, planiranje prostornog razvoja, kartografiju, 

planiranje puta i slično. (Geokvadrat,2020.) 

Četiri glavne ideje Geografskih informacijskih sustava (GIS) su: 

 stvaranje geografskih podataka, 

 upravljanje prostornim podacima u bazi podataka, 

 analiziranje i pronalazak obrazaca, 

 vizualizacija na karti. 

 

Slika 2-1 Geoinformacijski sustav koji povezuje veliki broj podsustava (GISgeography,2020.) 
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2.2 QGIS 
 

QGIS je open source GIS aplikacija. Softver je službeni projekt organizacije OSGeo (eng. 

Open Source Geospatial Foundation). Može raditi na Linux, Unix, Mac OSX, Windows i 

Android platformama, a podržava brojne vektorske i rasterske formate i formate baze podataka 

(QGIS, 2020). 

Softver nudi niz uobičajenih GIS funkcionalnosti, od kojih neke dolaze s programom, a neke 

se mogu nadograditi dodacima. Postoji šest generalnih kategorija koje softver posjeduje, a to 

su: 

Pregled podataka: Moguće je pregledati i preklapati vektorske i rasterske podatke različitih 

formata i projekcija bez pretvorbe u zadani ili zajednički format. 

Istraživanje podataka i izrada karte: Softver omogućuje izrađivanje karata i interaktivno 

istraživanje prostornih podataka s pristupačnim grafičkim sučeljem. Grafičko sučelje ili GUI 

(eng. Graphical user interface) sadrži mnoge korisne alate kao što su Map composer za izradu 

karata, Edit/view/search attributes - alati za izmjenu, pregled i pretraživanje atributa, prostorne 

oznake, QGIS pretraživač itd. 

Stvaranje, uređivanje, upravljanje i izvoz podataka: U softveru se mogu stvoriti, 

uređivati, upravljati ili izvoziti vektorski i rasterski slojevi u nekoliko formata. QGIS pruža alate 

za digitalizaciju vektorskih slojeva, dodatke za dekodiranje, podršku za prikaz i uređivanje 

podataka s OpenStreetMap-a, mogućnost spremanja snimke zaslona kao georeferencirane slike 

itd. 

Analiziranje podataka: QGIS omogućuje provođenje analize prostornih podataka kao što 

su vektorska analiza, uzorkovanje, geoprocesiranje te korištenje alata za upravljanje baze 

podataka. Svi ti procesi događaju se u pozadi što omogućava nastavak rada u QGIS-u prije nego 

što ti procesi završe. 

Objavljivanje karata na internetu: QGIS se može koristiti kao WMS, WMTS, WMS-C ili 

WFS klijent ili kao WMS, WCS ili WFS poslužitelj. Uz to, moguće je objaviti podatke na 

internetu pomoću webservera s instaliranim UMN MapServer-om ili GeoServer-om. 

Proširivanje funkcionalnosti dodacima: QGIS se može prilagoditi specifičnim potrebama 

korisnika uz pomoć različitih dodataka te mogućnosti stvaranja novih dodataka koristeći C++ 

ili Python programske jezike (QGIS Features, 2020). 
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2.3  Podatci u GIS-u 
 

  Podatci u GIS-u mogu bit vektorski, atributni i rasterski. 

Vektorskim podatcima objekte stvarnog svijeta prikazujemo točkom i njezinim koordinatama 

(x,y). Za modeliranje objekata iz stvarno svijeta koriste se tri geometrijska elementa i to su  

točka, linija  i poligon.  

Atributni podatci su opisne informacije o objektima to jest svi ne geometrijski podatci koji 

opisuju objekte. 

Rasterski podatci prikazuju model svijeta u kojem se koristi mreža ćelija tj. polja podijeljena u 

retke i stupce, osnovni element je piksel. Brojni GIS podatci zapisani su u rasterskom formatu 

kao što su  satelitske snimke, digitalni modeli visina, digitalni ortofoto, digitalni rasterski 

formati, grafičke datoteke (zemljovidi, fotografije, slike) (Osnove GIS-a,2015). 

U ovom završnom radu primjer vektorskih podataka su izohipse, primjer atributnih su visine 

koje su pridodane izohipsama, a sama karta je primjer rasterskog podatka. Najčešći GIS formati 

su:  

 Formati vektorskih podataka: Shapefile, XML (GML, KML, GPX), CAD (DWG, 

DGN, DXF), ESRI Coverage, ESRI Geodatabase, Geomedia  

 Formati rasterskih podataka: TIFF, GeoTIFF, JPG, JPEG2000, IMG, MrSID, ESRI 

Grid, BIL  

 

2.4  Prostorna analiza 
 

Prostorna analiza je proces manipulacije prostornim informacijama kako bi se iz izvornih 

podataka izvukli novi podatci i informacije. Proces traženja geografskih uzoraka u podatcima i 

traženje veza između objekata, kao i prostorno preklapanje dvaju ili više slojeva i stvaranje 

novih slojeva pri čemu se mijenjaju geometrijski podaci, ali i atributni podaci, najčešća su 

primjena prostorne analize. 

 VRSTE ANALIZA:  

o Od jednostavnih upita, matematičkih i logičkih operacija do zahtjevnih modela 

analiza  

 UPITI (eng. database query) 
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o Dohvaćanje atributnih podataka bez mijenjana postojećih podataka, jednostavno 

selektiranje ili kreiranjem više uvjeta (npr. Selekcija gradova koje imaju manje 

od 20 000 stanovnika) 

 REKLASIFIKACIJA  

o Dodjeljivanje novih vrijednosti  

 ANALIZA TERENA  

o Visine terena u odabranim točkama  

 PREKLAPANJE (eng. overlay)  

o Kombiniranje više prostornih objekata (slojeva) da bi dobili nove podatke (sloj) 

s pripadajućom geometrijom i atributima  

 ANALIZA BLIZINE  

o Mjerenje udaljenosti od točaka, linija, poligona   

 BUFFERING ili ZONA UTJECAJA 

o Određivanje objekata koji se nalaze u određenoj ‘buffer’ zoni. Zona se određuje 

oko osnovnih GIS objekata – točke, linije, poligona (npr. Objekti koji se nalaze 

50 m od neke ceste)  

 ANALIZA MREŽE  

o Određivanje optimalnih ruta, lokacija i sl.:  Najkraći put u mreži, pronalaženje 

svih mogućih veza između dva objekta, troškovne analize povezivanja, 

vremenske analize povezivanja (Osnove GIS-a,2020). 

 

 
2.5 Prostorna interpolacija 
  

Prostorna interpolacija je postupak korištenja točaka s poznatim vrijednostima za procjenu 

vrijednosti u drugim nepoznatim točkama. U izradi ovog završnog rada koristi se prostorna 

interpolacija da bi se dobio rasterski prikaz terena Svete Nedelje pomoću slojnica koje su 

prethodno označene u GIS-u. Prilikom izrade završnog rada koristi se metoda mreže nepravilnih 

trokutova (Spatial analasys,2020). 
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2.6  Mreža nepravilnih trokutova (triangulated irregular network TIN)  
 

  TIN interpolacija je još jedan popularan alat u GIS-u. Uobičajeni algoritam TIN-a naziva se 

Delaunayeva triangulacija. Pokušava stvoriti površinu koja je formirana trokutima najbližih 

susjednih točaka. Da bi se to učinilo, stvaraju se krugovi oko odabranih točaka uzorka i njihovi 

presjeci spojeni su na mrežu koja se ne preklapa i tvore što je više moguće kompaktnijih 

trokutova. 

Glavni nedostatak TIN interpolacije je taj što površine nisu glatke i mogu dati nazubljen 

izgled. To je uzrokovano povremenim padinama na rubovima trokuta i uzorcima podataka 

(Spatial analasys,2020). 

 
Slika 2-2 Prikaz TIN interpolacije područja Svete Nedelje podatci dobiveni iz topografske karte 1:25000 

 

 

2.7 SRTM (eng. Shuttle Radar Topography Mission) 
 

U posljednjem dijelu završnog rada korišten je SRTM model terena Svete Nedelje. SRTM je 

satelitsko snimanje zemljine površine koristeći radar sa sintetičkim otvorom blende i 

interformetriju. SRTM je prikupio jedan od najtočnijih digitalnih modela elevacije Zemlje s 

preciznošću visine oko 16 metara. Podatci se mogu slobodno preuzeti s USGS earth explorer 

stranice. Nedostatak SRTM je to što ne može razlučiti velike krošnje stabala tako da će u nekim 
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područjima visina biti definirana za visinu krošnji stabala, a ne za sam teren. Ovaj način 

snimanja zemljine površine vrlo je koristan za izradu klimatskih modela pomoću kojih se prati 

tok vode i protok zraka. Također je nadmorska visina dobar pokazatelj kopnenih formacija i 

tektonskih aktivnosti.(Gisgeography,2020.) 

 
Slika 2-3 Prikaz snimanja topografije pomoću satelita (Gisgeography,2020.) 
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3. OBRADA PODATAKA 
U ovom poglavlju opisan je praktični dio rada to jest koraci korišteni pri izradi karte visinskih 

razlika dobivenih iz visina s topografske karte u mjerilu 1:25 000 i visina iz satelitske misije 

SRTM-a. 

 

3.1 VEKTRORIZACIJA SLOJNICA 
Da bi se napravila karta 3D modela područja Svete Nedjelje prvo se trebaju vektorizirati 

slojnice topografske karte Svete Nedelje mjerila 1:25000 (Slika 3-1) u programu QGIS. 

Karta se u QGIS-u otvori pomoću izbornika Layer >  Add Layer  >  Add Raster Layer. 

Nakon što se karta učita stvori se novi Layer (Layer > Create Layer > New Shapefile Layer)  

pomoću kojeg se vektoriziraju slojnice. Kao geometrijski oblik izabere se Line, te se 

vektoriziranim slojnicama kao atribut pridoda njihova visina i pod Type izabere se Whole 

number (Slika 3-2).(Digitalizacija karte,2020) 

 
Slika 3-1 Georeferencirana topografska karta Svete Nedelje 
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Slika 3-2 New Shapefile Layer Stvaranje novog linijskog sloja 

 

Nakon toga se uključi opcija uređivanja (Toogle editing) i odabere opcija Add line feature te 

se prelazi preko slojnica karte i crtaju linije te se na kraju desnim klikom miša otvara Id table 

gdje se slojnici pridodaje njena visina kao atribut. Na slici(Slika 3-3) prikazana je atributna 

tablica. 

 
Slika 3-3 Atributna tablica 
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Boja linija te njihova debljina mogu se promijeniti pomoću kartice Symbology (desni klik na 

slojnice > Properties > Symbology) da bi se dodatno naglasile (Slika 3-4) 

 
Slika 3-4 Symbology 

 
Slika 3-5 Vektorizirane slojnice (lijevo);TK25 kao izvor podataka (desno) 

 

3.2 TIN INTERPOLACIJA 
Kako bi se mogla napraviti interpolacija potrebno je iz glavnog izbornika odabrati opciju 

Processing > Toolbox. Unutar prozora Processing Toolbox, izabere se funkcija TIN 

interpolation iz izbornika Interpolation. Nakon toga se u prozoru koji se otvori definiraju 
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parametri kao što je prikazano na slici 3-6. Vrlo bitno je da se kao atribut izabere visina jer se 

preko nje izvodi interpolacija. 

 

 

 
Slika 3-6 Opcije za generiranje TIN modela 

 

Da bi razlika u visina bila uočljivija tin_model se stilizirala pomoću opcije Properties > 

Symbology. 
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Slika 3-7 Symbology alat koji definira izgled prikazanog prostornog podatka korištenjem atributnih informacija 

 

Prikazu se dodaju i konture terena pomoću naredbe Raster > Extraction > Contour te se ispune 

parametri izbornika kao što je prikazano na slici (Slika 3-8). 

 
Slika 3-8 Opcije za generiranje kontura kojima se dodatno naglašavaju visinske razlike 

 

  Radi bolje preglednosti slojnicama se dodaje opis; kako bi dodali opis slojnicama koriste se 

Labels opcije, iz Properties izbornika. Izgled oznaka definiran je u kartici prikazanoj na slici 3-

9. 
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Slika 3-9  Opcija Labels u kojoj se definira izgled opisa izohipsi 

 
Slika 3-10  

 

Interpolirana karta Svete Nedelje s naznačenim vrijednostima izohipsi 
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Na donjoj slici prikazan je SRTM model koji će se uz prethodno dobivenu interpoliranu kartu 

koristiti u idućem koraku pri izračunu visinske razlike. 

 

 

 

 

 

 

 

 

 

 

 

Slika 3-11 Digitalni model terena dobiven pomoću satelitske misije SRTM 

 

 

 

3.3 Izračun razlika visina između SRTM  i TK25  
 

U posljednjem dijelu završnog rada napravljena je usporedba između TK25 3D modela i 

SRTM 3D modela, tako što se u QGIS-u izradi karta koja prikazuje razliku između ta dva 

modela.  

Srtm_sveta_nedelja.tif je digitalni model terena za to područje dobiven pomoću satelitske 

SRTM misije u HTRS96 koordinatnom sustavu. 

Tin_model.tif je digitalni model terena dobiven iz slojnice u HTRS96 koordinatnom sustavu 

što je objašnjeno u prethodnim koracima završnog rada. 

 

Nakon što se učitaju rasterski slojevi srtm_sveta_nedelja i tin_model u QGIS-u prvi je korak napraviti TIN 
interpolaciju za područje analize htrs96, dimenzije jednog piksela su 10m u X i Y smjeru. Parametri su 

prikazani na slici ( 

Slika 3-12).  
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Slika 3-12 Tin interpolacija htrs96 

Kako rasteri tin_model_htrs96 i srtm_sveta_nedelja_htrs96 zauzimaju šire područje od 

područja za izračun visinskih razlika potrebno ih je bilo odrezati na zadano područje. To se 

izvodi pomoću opcije Clip raster by mask layer. (Slika 3-13) 
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Slika 3-13 Clip raster 

Parametri se ispune kako je prikazano na slici3-14. 

 

 
Slika 3-14 Clip raster by mask layer 
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U idućem koraku se izračuna razlika između srtm_sveta_nedelja_clip i 

tin_model_htrs96_clip. To računamo pomoću funkcije Raster calculator (Raster > Raster 

calculator) 

 
Slika 3-15 Raster Calculator 

 

 Dobivena razlika se dodatno uredi pomoću opcije Symbology 

.  

Slika 3-16 Opcija Symbology u kojoj se definira izgled visinskih razlika 
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Slika 3-17 Karta visinskih razlika 
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4. ZAKLJUČAK 
U ovom završnom radu vektorizirane su slojnice topografske karte Svete Nedelje nakon čega 

se to područje interpoliralo da bi se mogla napraviti usporedba s visinama dobivenim 

satelitskom misijom SRTM. Za to je korišten softver QGIS  u kojem se vektoriziraju slojnice 

karte pomoću kojih se kasnije napravi prostorna interpolacija metodom mreže nepravilnih 

trokutova također u softveru QGIS.U posljednjem dijelu napravljena je usporedba s modelom 

visinske izmjere na tom terenu pomoću satelitske misije SRTM i dobivena je karta gdje su 

naznačene najveće i najmanje razlike u tim modelima. Na karti područja prikazana plavom 

bojom prikazuju veća odstupanja u visinama jer se upravo na tom dijelu nalaze šume, a jedan 

od nedostataka SRTM-a je to što ne može razlučiti krošnje stabala pa je visina terena definirana 

za visinu krošnji. Svijetlo narančasta područja prikazuju urbanizirani dio Svete Nedelje kojeg 

većinom čine manje stambene zgrade ili kuće te je zbog toga  manja visinska razlika između 

vektorizirane topografske karte i karte snimljene SRTM misijom. Prilikom izrade završnog rada 

QGIS se pokazao kao jako praktičan i koristan alat, te mu jedinu zamjerku predstavlja to je što 

je vektorizacija slojnica manualna, te zbog toga oduzima više vremena, te će se, ukoliko se u 

bližoj budućnosti uvede automatska vektorizacija, uvelike olakšati i ubrzati rad u QGIS-u. 
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